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Disclaimer

The material in this document is for information purposes only. The content and the product described are subject to
change without notice. Honeywell makes no representations or warranties with respect to this document. In no event
shall Honeywell be liable for technical or editorial omissions or mistakes in this document, nor shall it be liable for any
damages, direct or incidental, arising out of or related to the use of this document. No part of this document may be
reproduced in any form or by any means without prior written permission from Honeywell.

Copyright © 2021 HONEYWELL International, Inc. All rights reserved.

Software License Advisory

This document supports software that is proprietary to Honeywell International Inc. and/or to third party software
vendors. Before software delivery, the end user must execute a software license agreement that governs software use.
Software license agreement provisions include limiting use of the software to equipment furnished, limiting copying,
preserving confidentiality, and prohibiting transfer to a third party. Disclosure, use, or reproduction beyond that
permitted in the license agreement is prohibited.

Trademark Information

Honeywell logo, WEB-8000, WEBs-N4, WEBStation, Sylk, CIPer and Spyder are trademarks of Honeywell, Inc.

LON, LonMark, LonWorks, LNS, and Neuron are registered trademarks of Echelon Corporation. BACnet and ASHRAE
are registered trademarks of American Society of Heating, Refrigerating and Air-Conditioning Engineers. Microsoft,
Excel, Internet Explorer, Windows, Windows Vista, Windows Server, and SQL Server are registered trademarks of
Microsoft Corporation. Oracle and Java are registered trademarks of Oracle and/or its affiliates. Mozilla and Firefox
are trademarks of the Mozilla Foundation.

Niagara Framework ®, NiagaraAX Framework are registered trademarks of Tridium, Inc. All other product names and
services mentioned in this publication that are known to be trademarks, registered trademarks, or service marks are
the property of their respective owners.
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About this Guide

This document explains about the Sylk Actuator Analytics dashboard and how to configure the dashboard for Sylk
Actuator when it is connected to WEB-8000 via Spyder controller, and WEB-8000 is connected to a supervisor and a
Sylk Actuator is connected to a supervisor via CIPer Model 30 controller. The dashboard is designed to display
information derived from various parameters which help the users to monitor the performance of the Sylk Actuators.
Configuration and management are carried out using Sylk Actuator Service which is based on the WEBs-N4
Supervisor.

Itis recommended that you have some training or previous experience working with the CIPer Model 30 controller as
well as the WEBs-N4 supervisor.

Applicable Technical Literature

For additional information regarding the configuration, refer to the below listed documents.

Document Title Document ID
Sylk Actuator Analytics Service Installation Instructions 31-00421
ClPer Model 30 System Engineering User Guide 31-00237
ClPer Model 30 Installation and Operation Guide 31-00206
ClPer Model 30 Installation Instructions 31-00183
Spyder Tool User Guide for WEBs-N4 31-00089
Spyder® BACnhet® Programmable Controllers Installation Instructions 62-0310

® . .
Spyder~ Lon Programmable Controllers, VAV/Unitary Controllers Installation 62-0287
Instructions

For more information on the other WEBs products described in this guide refer to the docs folder of the WEBs-N4
installation (for example, CA\Honeywel\WEBStation-N4-4 X X XXX X\docs) or contact your nearest Honeywell office.

31-00420-01 4
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System Requirements

Requirement Source

Workbench Honeywell WEBStation-N4. X.
Software ClPer Model 30 latest released tool
Browser Latest Google Chrome

Sylk Actuator is connected to WEB-8000 via Spyder controller, and WEB-

Controller 8000 is connected to a supervisor.

Sylk Actuator is connected to a supervisor via CIPer Model 30 controller.

Network Architecture

The Sylk Actuator Analytics Service supports actuators which are connected to Spyder or CIPer Model 30 controllers
via Sylk bus (supported actuators are- Zelix MS3103, MS3105, MS3110, MS3120, and Diamond Sylk Actuator. Sylk
Actuator is connected to WEB-8000 via Spyder controller, and WEB-8000 is connected to a supervisor. Sylk Actuator
is connected to a supervisor via CIPer Model 30 controller. Refer the figure below to understand the Network
Architecture.

[
Web Browser
WEBs-N&
Supservisor
WAN/ LAN
WEE-S000 WEB-8000 WEB-8000 Clper 30 Clper 30

a

| Sypder Controlier

o e e e
g e

Network Architecture

-

"
E

-
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Introduction
The Sylk Actuator Analytics is a service to visualize the actuator performance, health, and predictive analytics of

service life. The service can be configured using WEBs-N4 workbench and ClIPer Model 30. Once configured, the
service is available for use via. WEBs-N4 workbench and web browser.

Prerequisites
Inputs and outputs for Sylk enabled actuators

The Sylk Actuator configured has five inputs and two outputs. All the I/0s communicate with the Spyder and ClPer
Model 30 controllers over a Sylk bus.

Outputs Inputs
e Actuator Position e Actuator Command
e Actuator Cycle Count e Actuator Travel Time

e Actuator Status
e Actuator Overridden

e Actuator Power Report

31-00420-01 6
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Supervisor Station configuration

The Niagara Network properties required for Sylk Actuator Analytics can be configured automatically with the Auto-
Configure Niagara Network property or using manual configuration options. The Persist Fetched tags property and
tagsToFetch slot is configured automatically using auto-configure Niagara network functionality. Right-Click on

SylkActuatorService - Views - AX Property Sheet > Auto Configure Niagara Network. Set this property as true.

You may also configure the Niagara Network manually using the Manual Configuration of Niagara Network.

Auto Configure Niagara Network

Use the Sylk Actuator Service property sheet for auto configuration of the Niagara Network properties. Follow the
steps mentioned below:

1

2
3.
4

5.

Drag and drop the SylkActuatorService from the palette to the Supervisor station container.

Go to the navigation tree on the left pane and open the AX Property Sheet of the SylkActuatorService.
Set the Auto Configure Niagara Network property to true. This property is set to false by default.

As an alternative, right Click on SylkActuatorService - Actions &> Configure Niagara Network.

[Nl weBStation N4

File Edit Search Bookmarks Tools Window  Help

. Station (SylkActuator_Supervisor) . Config . Services . SylkActuatorService
- Nav Property Sheet
# o ) My Network [l SylkActuatorService (Sylk Actuator Service)
. [ status {ok}
@ HierarchyService [‘i Fault Cause
@ HistoryService m Enabled .true

OAuditHistorySeruice m sylk Actuator Sylk Actuator

LogHistoryServi
© Logistoryservice (@ Auto Configure Niagara Network (@ false

Actions b  Configure Niagara Network

New

1 Edit Tags

& Make Template
Cut

6 Drivers Copy
© Niagaraner[iEEE

@ apps Paste Special
© Files Duplicate
@ Hierarchy Delete
@ History

Once the auto configuration is done, Persist Fetched Tag property is enabled and a slot with name
tagsToFetch will be added. The Slot will have tags s:ActuatorCycleCount and s:ActuatorName added
init.

7 31-00420-01
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Property Sheet
€ NiagaraMetwork (Miagara Network)
[ status |{ok}

i ensbiec

[l Fault Cause |

» E Health Ok [21-0ct-20 3:31 PM EDT]

» @) Alarm Source Info Alarm Source Info

» B Moniter Ping Monitor

» B3 Local station SylkActuator_Supervisor [ ip:192.168.0.1%...
b @ Sys Def Provider Bog Provider

» X Tuning Policies Miagara Tuning Policy Map

» [@ History Policies History Network Ext

b &F Workers Cyclic Thread Pool Worker

» [ virtual Policies Miagara Virtual Network Ext

[l Persist Fetched Tags

b € ProvisioningNwExt Provisioning Miagara Metwork Ext
I [ tagsToFetch

s:ActuatorCyclefount; s: ActuatorName ||

31-00420-01 8
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Manual Configuration of Niagara Network

For manual configuration of the Niagara Network properties, follow the steps mentioned below:

1.
2.

S

Right-click on Config = Drivers > NiagaraNetwork node in the Navigation tree.
Click Views = AX Slot Sheet.
The AX Slot Sheet view is shown in the figure below.

Slot Sheet

Slot # Name Display Name Definition Flags Type Facets B
O Property 3  health Health Frozen rd driver:PingHealth

O Property 4  alarmSourcelnfo Alarm Source Info Frozen alarm:AlarmSourcelnfo

O Property 5 monitor Maonitor Frozen driver:PingMonitor

OAction 6 ping Ping Frozen a void (void)

O Action 7 ackalarm Ack Alarm Frozen h baja:Boolean (alarm:AlarmRecord)

O Property & localStation Local Station Frozen niagaralbriverLocalSysDefStation

O Property @  sysDefProvider Sy Def Provider Frozen niagaraDriver:SysDefProvider

O Property 10 tuningPolicies Tuning Polidies Frozen niagaraDriver:NiagaraTuningPolicyMap

o Property 11 historyPolicies History Policies Frozen driver:HistoryNetworkExt

O Property 12 workers Warkers Frozen niagaraDriverCyclicThreadPoolWorker

O Property 13 virtualPolicies Virtual Policies Frozen niagarabriver:NiagaraVirtualNetworkExt

O Property 14 persistFetchedTags Persist Fetched Tags Frozen baja:Boolean

O Action 15 resetAllConnections Reset All Connections Frozen ac void (void)

O Action 16 submitStationDiscoveryJob Submit Station Discovery Job Frozen baja:0rd (void)

OAction 17 rebuildStationMap Rebuild Station Map Frozen ha void (void)

OAction 18 forceUpdateNiagaraProxyPoints  Force Update Niagara Proxy Points  Frozen c baja:0rd (void)

O Property 19 ProvisioningMwExt ProvisioningMNwExt Dynamic provisioningNiagara:ProvisioninghiagaraMetworkExt

Right-click in the white space and select Add Slot option.
Name the slot as tagsToFetch.

Set Type as baja String.

Click OK to proceed.

Add Slot X
N

MName

Type
baja String ® -

Change the view to AX Property Sheet view.
Add tags for actuators in tagsToFetch field s:ActuatorCycleCount;s:ActuatorName.

Enable Persist Fetched Tags property (change the value from false to true).
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Property Sheet

 NiagaraNetwork (Niagara Network]

v v Vv Vv vy v v v w

m Status

m Enabled

[l Fault Cause

L Health

© Alarm Source Info
L] monitor

Ed Local Station

& Sys Def Provider

X Tuning Policies

[l History Policies

& workers

@ virtual Policies

[ Persist Fetched Tags
€ ProvisioningNwExt
[l tagsToFetch

o SupervisorExportTaghetworkExt

10

{ok}

. true

Ok [25-5ep-20 3:48 PM IST]

Alarm Source Info

Ping Monitor

SylkActuatorSupervisor [ ip:192.168.225.4...
Bog Provider

Niagara Tuning Policy Map

History Network Ext

Cyclic Thread Pool Worker

Niagara Virtual Metwork Ext

. true

Provisioning Niagara Network Ext
s:ActuatorCycleCount; s: ActuatorName

Supervisor Export Tag Network Ext
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Configuring BACnet Spyder Controller

Adding BACnet Spyder Controller in the Station

1. Click( .) Open Palette button on the Palette to launch the Open Palette dialog box.
2. Type Honeywell to open the honeywellSpyderTool palette and click OK.
Nl Open Palette X

Select one or more palettesto open, orjust start typing:

gy ’

3. Onceitis added, the honeywellSpyderTool is reflected in Palette as shown below.
~ Palette A
W X 23 @ honeywelisoyderTool H

=) BACnetSpyder

LonSpyder

© PhysicalPaints
© softwarePoints
o Analog

o Logic

Q) Math

o Control

o DataFunction
© zonearbitration
Q Builtin

Q util

v v v v ¥ v ¥ ¥ wv v Ww v

11 31-00420-01
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4. Add BACnet device: Select BACnetSpyder controller from the Palette (tool library) then drag and drop it
on the BacnetNetwork. The name window will pop up.

5. Enter the name and click OK to verify the added controller, expand the Bacnet network tree.

Name X
@ BACnetSpyde

OK | Cancel

6. The BacnetSpyder device is added to the BacnetNetwork as shown below.

ﬁ BacnetMetwork
- Local Device
E Bacnet Comm

Q Manitor

',I‘, Tuning Policies
é BacnetSpyder

Adding points to the Spyder Controller

The standard point folder templates are available preconfigured with all I/0 points. Add the points folder to
BACnetSpyder. Follow the steps below:

1. Open Palette and select SylkActuatorAnalytics module in the palette window.

- Palette
[} E] .@ i SylkActuatorAnalytics

r- SylkActuatorservice

'D PointFolderTemplates
A ciPer30PointsFolder
EH BacnetPointsFolder
EA NiagaraPointsFolder

2. Select BacnetPointsFolder.

3. Drop this folder under: Station> Config> Drivers>BACnet Network-> BACnet Spyder-> Points.

4. Name it as per requirement/device to which it's connected. For example, OADamper.

=3 BacnetSpyder
ﬂ Alarm Source Info

'E' Points

B oaDamper

31-00420-01 12
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Configure Point Database

1. Doubleclick onthe OADamper folder added and open the BacnetSpyder Point manager.

2. Click the Discover button to discover all the points on the device.

° Bacnet Discover Points Success )} E]
Discovered 119 objects
Object Name Object ID Property I Index Value Description &
Alslk12_I10_ActuatorStatus analoglnput:18  presentvalue 0.00 Property:Unknown Property:analoginput: 18 [description]
AlSlk12_|10_ActuatorOverridden  analoglnput:1®  presentValue 0.00 Property:Unknown Property:analoglnput:19 [description]
Alslki2_I0_PowerReport analoglnput:20  presentvalue =inf Property:Unknown Property:analoginput:20 [description]
Alslk11_|0_ActuatorPosition analoginput:21 prezentValue 76.58 Property:Unknown Property:analoginput:21 [description]
Alslkil 10 ActuatorCycleCount analoginput22  presentValue 233.00 Property:Unknown Property:analoglnput:22 [description]
Alslk11_10_ActuatorStatus analoglnput:23 prezentvalue 0.00 Property:Unknown Property:analoginput:23 [description]
AISlk11 10 ActuatorOverridden  analoslnout24  presentValue 0.00 Propertv:Unknown Propertvianslosinout:24 [descrintion]
Database T objects
Name Out Object ID Property ID  Index Read Write &
ActuatorCommand 76.3% [0k} @def analogOutput:@  PresentValue -1 Polled OK
ActuatarPosition 76.6{ok} analoginput:21 PrezentValue -1 Polled Read Only
ActuatorCycleCount 233 [ok} analoginput:22  PresentValue -1 Polled Read Only
ActuatorTravelTime 30.00 {ok} @def  analogOutput:10 PrezentValue -1 Polled OK
ActuatorOverridden 0.0% {ok} analoglnput:24  PresentValue -1 Polled Read Only
ActuatorStatus 0.0{ok} analoglnput:23 PresentValue -1 Polled Read Only
ActuatorPowerReport  420.0{ok} analoginput:25 PrezentValue -1 Polled Read Only

B Cancel G-)Add »Hatch L] Taglt

3. Select one of the discovered points in the Discovered pane and one of the points with a corresponding

point from the database pane and click M

For example, select AISIk1_IO_ActuatorCycleCount from the Discovered pane and select
ActuatorCycleCount from the Database pane, click on Match. Match the remaining points similarly.

2 New Folder | DNew | I‘ Edit ‘ nDimver

N Match *

Name Type Enabled Object ID Property ID  Index Tuning Policy Name Data Type Read
ActuatorCycleCount MNumericPoint  true analoginput:22 PresentValue -1 defaultPolicy REAL unsubs

l‘". Name ActuatorCycleCount
Type Cannot edit

li Enabled . true

l'—. Object ID Inalog Input 22

l'—. Property ID Present Value

l'—. Index -1

l'_.Tuning Policy Name Default Folicy

[ pata Type REAL

l'—. Read unsubscribed

l‘". Write readonly

l'—. Device Facets units=ub, priPV=false >> -

[ Facets units=ub S D -

l'—. Conversion .E Default

oK Cancel

13 31-00420-01
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4,

The ActuatorCycleCount point has a tag with name s:ActuatorName which is a string tag. The default
string value is %parent.parent.parent.name%_%parent.name% which works as a BFormat to read the
actuator name.

To change the BFormat:

a.
b.

C.

Right-click on ActuatorCycleCount point to open the options.
Click on ‘Edit Tags’ option
Check for the edit tags popup window to display values.

Change the BFormat in s:ActuatorName field to display the actual name of the Actuator. This will
be seenin the chart displayed.

The BFormat should be written considering the point hierarchy in the Supervisor station.
A string without BFormatis also supported.

Click on Save after the changes are complete.

" Edit Tags: ActuatorCycleCount x
@ Niagara ﬂ ? Show All
Tag Dictionary 25 objects
MName Type B
= ‘Tﬂgs
‘blndHlnts string
‘dewce Marker
dizplayName string
‘geo,—'\ddr String
..., Chrimm

Direct Tags ~ Implied Tags

[@ direct (Component)
@l stActuatorCycleCount ‘ marker

ol siActuatorMame $parent.parent.parent.name$_%$parent.name’

Save @AddTag | xnemnveTag ‘ W cancel

Importing Database to the Supervisor station

The points are added using a template. They are pre-configured with history extensions and tags.

1

2
3.
4

31-00420-01

Go to Window > Side Bars > Palette > enter exportTags.

Add the SupervisorExportTagNetworkExt to the NiagaraNetwork of Supervisor station.

Add the SubordinateExportTagNetworkExt to the NiagaraNetwork of the controller station.

The Supervisor station field in the PointTag and HistorylmportTag is empty by default and must be
configured to push the points to the Supervisor station.

14
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Damper

- Actuator

Property Sheet
() ActuatorCycleCount (Numeric Point)

[l Facets

» [3 Proxy Ext
= Qut

» [J Numericinterval

w & PointTag

[l status
[l Enabled

m Supervisor Station

[ station Slot Path

[l conversion

[l Tuning Policy Name
@l s:ActuatorCycleCount
E siActuatorMame

units=nullprecision=0 3 D -

analoginput:-1:Present Value:-1:
0 [down,stale]
Numeric Interval History Ext
Point Tag

{ok}

. true
® ]

Actuatorsu or
SlotipULILE, SHELWOLKL UIUErrdLns

rE Default

defaultPolicy

‘ marker

jparent.parent.parent.nameiiparent.names

5. Configure the export tag extensions using the Join Profile manager view and right-click on the
SubordinateExportTagNetworkExt - Actions = Join
a. The Join action adds the points and histories in the Supervisor station.

: Config

/ Niagara Point Manager

> [ & wmynetwork

.
b AHUD2
v g AHUD1

] °Alarm50urce\nfo
] ocl\enthnnectlcn

v @ points
» [ aHun
+ H points
~ [ oaDamper

P OActuatorCommand
] OActuatorPos\tlon
» () ActustorTravelTime
b (D) ActuatorOverridden
] QActuaterStatus
4 QActuaterPcwerReport
b OActuatorCycleCount

» [ aHunz

* Drivers © NiagaraNetwork o AHUO1 . Points I AHUOL I points o DADamper
Database
Name Point Id
(! ActuatorCommand i s /points/Of ‘ommand
0 . - "y Ipoints/O 0
(. ActuatorTravelTime i i Ipoints/Ol ) A
0 ActuatorQverri i e [points/O) /s
0 = oy Inoints/Oy 4
0 - ny Ipoints/O i
() ActuatorCycleCount i ks Ipoints/O i cycleCaunt

15

Out

0.0% [down stale] @ def
0.0% {down,stale}
0.0s{down stale} @ def
0.0% {down,stale}
0.0{down stale}

0.0 {down stale}
0{down,stale}

Subscription Status
Subscribed
Subscribed
Subscribed
Subscribed
Subscribed

7 objects

B

31-00420-01
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bal.ds.honeywell.com 7 Station (SylkActuatorSupervisor) Config Drivers NiagaraNetwork AHUO1 Histories _/. Niagara History Import Manager
AR Discovered 0 objects
Ty Network H History ID  System Tags B
=% . - R
& AHUO2
& AHUOL

» €D clientConnection
v @ roints

» Hadun

» H aruoz

b Q) slarm Source Info I

b H aduos

» B RADamper
» m AHU05_0DDamper Database ' 3 objects
o Histories Name History Id Status State Last Success On Demand Poll Enabled  On Demand P B
o Alerms & Remote_AHU01_OADamper_ActuatorCycleCount #AHUO1_OADsmper_ActuatorCycleCount {ok} Idle  17-5ep-208:34PMIST  true Narmal

© schedules
o Users

© sysoef

0 Virtual o

& Remote_AHUO01_OADamper_ActuatorCommand  “AHUO01_OADamper_ActuatorCommand  {ok} ldle  null true Normal

2% Remote AHUO01_OADamper_ActustorPosition AAHUO1_OADamper_ActuatorPosition {ok} ldle  null true Normal

6. The history capacity is set as unlimited by default.

7. Configure the capacity from record count option to a specific number and the default execution time is
set to daily by default. This will update the wizard once a day.

8. Change the execution time to shorter interval for more frequent update.

31-00420-01 16
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Configuring CIPer Model 30 Controller.

Adding a Device to IPC Network

LocalDevice is present by default when the network is added. To manually add a device:
¢ Select the IPCNetwork from the ipcProgrammingTool Palette (tool library).

¢ Drag-drop the LocalDevice to the IPCNetwork in Drivers under Station.

5 Config
@ SEMVices
a Drivers

a NiagaraMetwork
) IPchetwork
; LocalDevice

NOTE

Pre-requisite: Device engineering logic should be created on ClIPer Model 30 controller as per its standard
software programming. Refer to “CIPer Model 30 System Engineering User Guide - 31-00237" for detailed
information on Sylk Actuator’s I/0 configuration.

Steps to add points to CIPer Model 30 Controller.

Standard point folder templates are available preconfigured with all I/0 points. To add the points folder to ClPer
Model 30 Controller, follow the below mentioned steps:

1. Openthe SylkActuatorAnalytics module using the palette and expand the point folder templates.

- Palette
] E .@ i SylkActuatorAnalytics

. SylkActuatorService

D PointFolderTemplates
EA CiPer3oPointsFolder
H BacnetPointsFolder
EA niagaraPointsFolder

2. Select CIPer30PointsFolder.

17 31-00420-01
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3. Drop this folder under: Station > Config > Drivers > IPCNetwork - LocalDevice > Points » Sequenced
Control Program.

4. Name it as perrequirement/device to which it’s attached. For example, OADamper.

ﬂ' Drivers

'ﬁ' MiagaraNetwork
ﬁ BacmetNetwork
) rcetwork
; LocalDevice
'ﬂ' Alarm Source Info
$ FPoints
E sequenced Control Progral
F-1 OADamper

Configure Point database

1. Navigate to the configured device Sylk I70 points and open the Wire Sheet view.
2. Right-click on Sylk IO point and select Link Mark. For example, ActCmd as shown below. This will serve as

the source point.

tuatorfdd

tddril

Ctri+X
Ctrl+C

Ctrl+v

=in Paste Special

Duplicate Ctrl+D

CycleCountAddrii Delete Delete
Sylk Actustor Output Param

sylkDevice
status
polllnteneal
out

Link Mark

3. Doubleclick on the “OA Damper” point folder to open. Right-click on the corresponding point added from
the point template - ActuatorCommand. Select Link From “ActCmd” option.

31-00420-01 18
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Views

Actions
. Drivers . IPCN—————————————ints
Edit Tags

m SyllkActuatoy
e Template

Wire Shest
Cut Cirl+X

Copy Ctrl+C
Paste Ctrl+Vv
Paste Special

Duplicate Ctrl+D
Delete Delete

Link From "ActCmd"

Relation Mark

4. Define the source and target pin slots.

Link X
ActCmd [Source] ActuatorCommand [Target]
‘Iné
| Out ] In7
In1 In3
In2 W In9
In3 *In10
In4 In11
L
In5 In12
In6 W In13
In7 In14
In8 In15
In8 In16
In10 v Fallback
In11 Override Expiration
Link ActCmd.out-> ActuatorCommand.in16
OK Cancel

5. Alink will be created to the point added from the template. Similarly link all the other points.
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Wire Sheet
ActuatorOverridden
Mumeric Writable
Out 0.0 % ok} @ 18]
In10 - Tnull}
B4 In16 0.0 %% fokd)

ActuatorTravel Time
Numeric Writable

Out 45.0 5 ok} @ 16|
In10 - Tnull}
B4 In16 45.0 5ok}

ActuatorCycleCount
Numeric Writable

Out 2587.00 {ok} @ 16|

Inim - {null}
1= [T 2557.00 {ok}

ActuatorP osition

Numeric Writable

Out €9.1 % {ok} @ 16|

Inio - {null}
1= [T &3.1 % ok}

ActuatorCommand

Numeric Writable

Out €9.5 % {ok} @ 16

Inim - {null}
B4 In16 £9.5 % fok]

6. The ActuatorCycleCount point has a tag with name s:ActuatorName which is a string tag. The default
string value is %parent.parent.parent.name®%_%parent.name% which works as a BFormat to read the
Actuator name.

7. Tochangethe BFormat:

a. Rightclick on ActuatorCycleCount point.
b. Click on Edit Tags to open edit popup for editing the tags.
c. Change the BFormat in the string field to display the point name as actuator name on the chart.

d. The BFormatshould be written considering the point hierarchy in the Supervisor. A string without BFormat
is also supported.

e. Click on Save after the changes are complete.
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. Edit Tags: ActuatorCycleCount X
ﬁ Niagara % ? ShowAll
Tag Dictionary 25 objects
Name Type i
= ‘Tags
‘hindHints String
‘dr:vice Marker
displayName String
OgeoAddr String
- P Chrimm

Direct Tags = Implied Tags

(W direct (Component)
@ s:ActuatorCycleCount @ marker

a s:ActuatorName $parent.parent.parent.name%_%$parent.name’

mSave @AddTng | xRemoveTng | B cCancel

Importing Database to the Supervisor station

The database points are added using a template and are preconfigured with history extensions and tags.
1. Goto Window > Side Bars > Palette > enter exportTags.

2. Add the SupervisorExportTagNetworkExt to the NiagaraNetwork of Supervisor station.

3. Add the SubordinateExportTagNetworkExt to the NiagaraNetwork of the controller station.

4

The Supervisor station field in the point tags and HistorylmportTag is empty and should be configured to
push the points to the Supervisor station.

IPCHetwork . LocalDevice . . Seguenced Control Program . RADamper . ActuatorCycleCount . PointTag
Property Sheet
(& PointTag (Point Tag)
m Status {ok}
@ Enabled @ e
m Supervisor Station @ [z]
SylkActuatorSupervisor
m Station Slot Path 310t IPULILS/ SpALelll. parelll. nane [} ’
m Conversion 'E Default
[l Tuning Policy Mame  |defaultPolicy

5. Configure the export tag extensions using the Join Profile manager view and right-click on the
SubordinateExportTagNetworkExt > Actions > Join.
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6. Join action will add the points and histories in the Supervisor station.

. AHUO1 . RADamper K 4 Niagara Point Manager
Database 7 objects
twark Name Point Id out Subscription B
» B aHUD1Z 0 ActustorCycleCount  slot:/Drivers/IPCNetwork/localDevice/points/SequencedControlProgram/RADamper/ActuatorCycleCount  -{null} @def Subscribed
» E aHuozs 0 ActustorCommand sloty/Drivers/IPCNetwork/localDevice/points/SequencedControlProgram/RADamper/ActuatorCommand -{null} @def Subscribed
[ RADamper 0 ActustorPosition slot:/Drivers/IPCNetwork/localDevice/points/SequencedControlProgram/RADsmper/ActuatorPosition -{null} @def Subscribed

» 0 ActuatorCycleCount

OActuatorTravelTime sloty/Drivers/IPCNetwork/localDevice/points/SequencedControlProgram/RADamper/ActuatorTravelTime -{null} @def Subscribed
» OActuatorCommand

0 ActustorOverridden  sloty/Drivers/IPCNetwork/localDevice/points/SequencedControlProgram/RADamper/ActuatorOverridden  -[null} @def Subscribed

» (D ActuatorPosition . i

0 ActustorStatus slot:/Drivers/IPCNetwork/localDevice/points/SequencedControlProgram/RADamper/ActuatorStatus -{null} @def Subscribed
b (D actuatorTravelTime

0 ActustorPowerReport  sloty/Drivers/IPCNetwork/localDevice/points/SequencedControlProgram/RADsmper/ActuatorPowerReport - {null} @def  Subscribed
» (D actuatoroverridden
b (D Actuatorstatus

global.dshoneywelloom (BAS201S_0037 Station (SySkActuatorSupervisor)

NisgacaNetwork )0 Z  Niagara Mistory Import Manager ~

(1) Discovered 0objects
%) My Network History 10 System Tags »
Services
Orivers
0 NisgaraNeteork
b @ Provisionmghwist
» O supenvisoroponTa
» ; AHUR
v &AM
» ° Alarm Source It
» © clientConnect
» @ roints Database 3 objects
> © Histories Name History I Status  State Last Success On Demand Poll Enabled  On Demand Poll Frequenc @
» 4
g Ao & Remote_AMUOL_RADsmper_ActustorPosition AANUOL_RADamper_ActustorPosition fok) Idle  25-Sep-20TSIPMIST true Normal
’ Schedules
o 2R Remote_AHUOL_RADamper_ActustorCydeCount *AHUCL_RADsmper_ActustorCycleCount [ok) Idle 15-5ep-20TSIPMIST  true Normal
» Users
» O sysoef 2% Remote_AHUOI_RADsmper_ActustorCommand  *AHUO)_RADamper_ ActustorCommand (o]  Idle  25-Sep-207:52PMIST true Normal
» O virual

7. The history capacity is set as unlimited by default.
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8. Configure the capacity using record count option to a specific number and the default execution time. If it's
set to daily, it will update the wizard once a day. Change the execution time to a shorter interval for frequent
updates.

NOTE

If any changes to the tags are made in a controller station, right-click on the NiagaraNetwork
of Supervisor station and click Actions > Force Update Niagara Proxy Points.

Configuring ClIPer Model 30 Controller as a Supervisor

The Sylk Actuator Service can be included to enable the analytics on the CIPer Model 30 Controller. The analytics
wizard will display the actuators connected to the CIPer Model 30 Controller. Steps given in the Supervisor
Station Configuration section are not required to configure a CIPer Model 30 Controller. Add the
SylkActuatorService to the station and follow the steps mentioned in the section Configuring ClPer Model 30
Controller.

Adding a Device to IPC Network.
For Already Existing Controllers

For Controllers which are not included using the template and exist already in the system, use the following steps to
configure them. Refer to Default Template Settings for more details on the history and alarm configuration required
for the points.

1. Add an adhoc baja:marker tag to the Actuator Cycle Count point as s:ActuatorCycleCount.

2. Add an adhoc baja:string tag to the Actuator Cycle Count point as s:ActuatorName when creating point
database in the controller.

3. Make sure that the Actuator Cycle Count point has history configured in the controller and imported to
the Supervisor station. The imported point should have n:history tag.

4. After adding the controller and completing the configuration, follow the below step:

Right-click on the NiagaraNetwork-> Actions-> Force Update Niagara Proxy Points

NOTE

Click on Force Update Niagara Proxy Points after completing configuration for all controllers. A frequent
Force Update Niagara Proxy Points would affect the station performance.
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Default Template setting

After successfully adding the corresponding points under Point Manager, you can verify or modify the settings
mentioned here for history extensions, alarm extensions, history import tags, tags, and point tags.

e Mandatory settings for Sylk Actuator Service to run are highlighted in bold. Refer table below for details on
the necessary settings.

e (Othersettings are set only as default and can be modified by the user.

e Thetemplate has 7 points out of which, one point from the template i.e., ActuatorCycleCount point is used for
analytics. The users can use the remaining points or remove as necessary.

The table below indicates all the points available in the template.

Point Name Tag History Alarm

Actuator Command Not required Not required Not required
Actuator Position Not required Not required Not required
Actuator Cycle Count s:ActuatorCycleCount — baja:marker Required Not required

s:ActuatorName — baja:string

Actuator Travel Time Not required Not required Not required

Actuator Overridden Not required Not required Not required

Actuator Status Not required Not required Not required

Actuator Status Not required Not required Not required
NOTE

If points are created manually, add an adhoc baj:marker tag to the ActuatorCycleCount point as
s:ActuatorCycleCount and adhoc baja:string tag to Actuator Name point as s:ActuatorName. To
configure the existing controllers, refer to the topic Configuring BACnet Spyder.
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The below table lists the mandatory settings to be configured for the Sylk Actuator Service.

Point Template

History Extension

Point Tag

History Tag

BacnetPointsFold
er

Numerical Interval History Ext
Interval — 15 min
Record Count — 8640 records

HistoryNameB-format:
%parent.parent.parent.parent.n
ame%o_

%parent.parent.parent.name®%o_

%parent.name%

Station Slot Path:

slot:points/%networkFolder
Path%

Station Slot Path:
slot:histories

History Import Name:
% defaultHistorylmportNa
me%o

ClPer30PointsFol
der

Numerical Interval History Ext
Interval — 15 min

Record Count —8640 records
HistoryNameB-format:

%sys().station.stationName%o_
%parent.parent.name%_’opare
nt.name%

Station Slot path:

Slot:points/%parent.parent.

name%

Station Slot Path:
slot:histories

History Import Name:
%defaultHistorylmportNa
me%

NiagaraPointsFol
der

Numerical Interval History Ext
Interval — 15 min

Record Count —-8640 records
HistoryNameB-format:

%sys().station.stationName%o_
%parent.parent.name%_%opare
nt.name%

Station Slot path:

Slot:points/%parent.parent.
name%o

Station Slot Path:
slot:histories

History Import Name:
%defaultHistorylmportNa
me%o
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Starting Sylk Actuator Service

Follow these steps to launch the Sylk Actuator Analytics Dashboard.
1. Navigate to the SylkActuatorService by the route: Station>Config> Service>SylkActuatorService.

a Config
@ Services
. SylkActuatorService
ﬂ AlarmService
@ BackupService

@ CategoryService

2. Double click on the SylkActuatorService to launch the SylkActuator dashboard.

3. Check for actuator parameters using the SylkActuatorAnalytics dashboard.

Honeywell | Sylk Actuator Analytics

DASHBOARD PERFORMANCE

Actuators Estimated Life Remaining

11 53%

9 2

Actuator Life

100%
90%

80%

JR LIFE REMAINING

JKES PER WEEK(Previous 12 Weeks)

ACTUATC

AVERAGE STR(

l 0

r r r T r r r " " r
ArU 'ZRADBT“OEAHU " SRADa"'gEAHungRADamHAHU meamoﬂwu ﬂRp.aamoemume.aampswu ezR‘\m"“’BAHUQBR‘\W"“’BAHUMRRW‘“‘”MUM opDampe!
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Sylk Actuator Analytics Dashboard

The below description details the various fields and widgets available on the Sylk Actuator Analytics Dashboard.

Navigation Pane Widgets
I Titlei: Bar

¥

1. Title Bar - It displays the dashboard name as ‘Sylk Actuator Analytics’.
2. Navigation Pane - It displays the list of pages available for navigation — Dashboard pane, Performance pane.

3. Dashboard -. The dashboard pane has multiple widgets.

i. Actuators: This widget displays the count of the total actuator and the healthy actuator.

ii. Alerts: This widget displays the number of Actuators currently in the Alarm. It also displays the Alarm
countfor This Week and This Month

iii. Estimated Life Remaining: This widget displays the average life remaining of all the actuators and

displays the actuators that would need replacement within 0-12 Weeks, 12-24 Weeks, and >24 Weeks
in terms of percentage out of 100.

iv. Actuator Life chart:
a. Y-axis

i. Actuator life remaining in the percentage out of 100 (Bar graph).

ii. Average strokes perweek (Line graph).

iii. The life remaining bar will have different colors based on the remaining life of the Actuators as per
the below legend:
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e Green:100-71%
e Yellow: 70-21%
e Red: 20 - 0%
b. X-axis: All the Actuators will be populated on the Graph and the user can filter the Actuators based on
the name of Actuators.
v. Dashboard Pane Filters
a. Sort:Itallows the userto sort the actuators based on the life remaining and the name of actuators. The
default sort is set to ascending order of life remaining of actuators.

b. Export Actuator Life Report: The report can be exported in csv format. The report will have columns to
display the Actuator name, Life remaining in percentage, and Average Strokes per week.

4. Performance Monitoring: The performance chart can display the following parameters.

Daily Average Actuator Strokes: This widget displays the daily average actuator stroke count of up to 10
actuators at a time. Every data point represents the average number of strokes for the selected actuator
in one day.

a. Y-axis - Average actuator strokes per day during the selected time range (Individual Line graph for
each selected actuator)

b. X-axis: The time scale represents the selected time range for which the daily average actuator stroke
is displayed.

c. Add Actuator: This selection allows to select of up to 10 actuators from the available dropdown list.

d. Time range: Time range can be selected for This Month, Last Month, This Year, Last Year, or Custom
range. For custom selection, the date range can be selected to start from any date to the following
duration for 30 days. The default time range for the chart is This Month.

Honeywell | SylkActuator Analytics

DASHBOARD PERFORMANCE

Daily Average Actuator Strokes

AHU11RADamper
AHUOZRADamper

R 2 R & & & & & 2 & 2R & & L & & &R
Y F F F F F O F F KL FF KL K F F KL L X K
,:) ,{9 ,;'J \x" ‘;) @5: ,“: %‘) 0'9 &0") ;:9 \,'5'% \,,.;9 »;) @5: \@‘; ‘;\‘) {;9 \?“)
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O
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Troubleshooting
Issue/ Problem Statement Troubleshooting
The actuator is added in the station but does 1. The actuator cycle count point should have
not appear on the dashboard charts s:ActuatorCycleCount, s;ActuatorName and n:history tag
assigned to it.
2. Right-click on Niagara Network -> Actions -> Force update
Niagara Proxy points.
The Sylk Actuator dashboard does not open Make sure the SylkActuatorAnalytics feature is available in the
license.
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